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1
About this guide

This chapter covers the following topics:

• What this guide covers (page 10)

• Conventions (page 11)

• About the BD FACSCelesta™ documentation (page 11)

• Instrument technical support (page 13)
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What this guide covers
This guide describes the procedures necessary to operate and 
maintain your BD FACSCelesta™ flow cytometer. Because many 
cytometer functions are controlled by BD FACSDiva™ software, 
this guide also contains information about software features 
required for basic cytometer setup and operation. 

This guide assumes you have a working knowledge of basic 
Microsoft® Windows® operation. If you are not familiar with the 
Windows operating system, see the documentation provided with 
your computer.
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Conventions
Introduction The following table lists the safety symbols used in this guide to 

alert you to potential hazards.

Safety symbols

About the BD FACSCelesta™ documentation
Introduction This topic describes the documentation available with the 

BD FACSCelesta™ flow cytometer.

Publication formats This guide is provided in PDF format to provide an eco-friendly 
option. All content is also included in the BD FACSDiva™ 
software Help.

Help system The help system installed with BD FACSDiva™ software includes 
all content from this guide and the documents listed below. Access 

Symbol Meaning

Caution/Warning alert
Identifies a hazard or unsafe practice that could result 
in data loss, material damage, minor injury, severe 
injury, or death

Biological hazard

Electrical hazard

Laser hazard
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the BD FACSCelesta™ help system from the Help menu in the 
BD FACSDiva™ software. Internet access is not required to use the 
help system.

The help system is compiled from the following documents:

• BD FACSDiva™ Software Reference Manual: Includes 
instructions or descriptions for installation and setup, 
workspace components, acquisition controls, analysis tools, 
and data management. Access this manual from the 
BD FACSDiva™ Software Help menu (Help > Documentation 
> Reference Manual), or by double-clicking the shortcut on the 
desktop. 

• BD FACSCelesta™ Flow Cytometer Site Preparation Guide: 
Contains specifications for:

– Cytometer weight and size

– Temperature

– Electrical requirements

• BD High Throughput Sampler User’s Guide: Describes how to 
set up and operate the BD High Throughput Sampler (HTS) 
option. It also contains a description of BD FACSDiva™ 
software features specific to the HTS.

• BD FACSFlow™ Supply System User’s Guide: Describes the 
optional automated sheath and waste fluid control system.

Additional 
Documentation

BD Cytometer Setup and Tracking Application Guide: Describes 
how to use the BD Cytometer Setup and Tracking (CS&T) features 
in BD FACSDiva™ software. You can find the document in the 
following location bdbiosciences.com/guide.

http://www.bdbiosciences.com/guide/
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Instrument technical support
Introduction This topic describes how to get technical assistance.

Contacting 
technical support

If technical assistance is required, contact your local 
BD Biosciences customer support representative or supplier. 

When contacting BD Biosciences, have the following information 
available:

• Product name, part number, and serial number

• Version of BD FACSDiva™ software you are using

• Any error messages

• Details of recent system performance

To contact customer support:

1. Go to bdbiosciences.com.

2. Select your region. You will see information in your local 
language. 

3. Click Go. 

4. Click the Support link for details for your local region. 

http://www.bdbiosciences.com
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Introduction

This chapter covers the following topics:

• System overview (page 16)

• Control panel (page 19)

• Fluidics system (page 20)

• Sheath and waste containers (page 27)

• Optics (page 28)

• Workstation (page 30)
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System overview
About the system The BD FACSCelesta™ system includes the BD FACSCelesta™ 

flow cytometer, BD FACSDiva™ software v8.0.1.1 running on the 
system workstation, the optional BD FACSFlow™ supply system 
(FFSS), and the optional BD High Throughput Sampler (HTS). 
Each component is described in detail in the following sections.

1 2 3

Number Components

1 Sheath and waste tanks

2 BD FACSCelesta™ flow cytometer

3 Computer workstation
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Cytometer overview
Introduction The BD FACSCelesta™ flow cytometer is an air-cooled multi-laser 

benchtop flow cytometer with the ability to acquire 10–12 
fluorescent parameters. It uses fixed-alignment lasers that transmit 
light through a flow cell to collect and translate the resulting 
fluorescence signals into electronic signals. Cytometer electronics 
convert these signals into digital data.

Components The following figure shows the main components of the 
BD FACSCelesta™ flow cytometer, which are listed in the table. 
Each component is described in detail in the following sections.



BD FACSCelesta™ Flow Cytometer User’s Guide18

8

2
3

6

4

5

9

7

1

Number Component

1 Heat ventilation slots (top)

2 Control panel

3 Power button

4 Electrical plug

5 Fluidic sensor ports

6 Sample injection port (SIP)

7 Heat ventilation slots (left side)

8 Air and fluidic ports

9 Optics access door (polygon 
detector arrays)
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Control panel
Overview The following figure shows the components in the control panel, 

which are listed in the table.

Caution! Do not place any objects on top of the 
instrument. Blocking the ventilation may cause the 
instrument to overheat.

Caution: Electrical Hazard! Do not place liquids on top of 
the instrument. Any spill of liquid into the ventilation 
openings could cause electrical shock or damage to the 
instrument.

1 2

3 4 6

5

Number Component

1 System indicators

2 Fluid control buttons

3 Sample flow rate buttons
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More information • Fluidics system (page 20)

• Optics (page 28)

Fluidics system
Introduction The fluidics system carries the sample out of the sample tube and 

into the interrogation region of the flow cell. Cells are carried in 
the sample core stream in single file and measured individually.

System indicators There are two system indicators (System Status and Activity) on 
the control panel.

• System Status. Shows the status of the sheath and waste tank 
levels. The following table describes the LED indicators, 
conditions that trigger them, and any action that must be 
taken.

4 Sample fine adjust buttons

5 Status screen

6 MODE button

Number Component

LED color Status Action Condition

Green Good None Good

Yellow Caution! Sheath 
and/or waste tanks 
need attention.

Check tank levels Sheath low and/or 
waste nearly full

Red Caution! Take 
immediate action.

 Empty waste tank

 Fill sheath tank

Sheath empty and/or 
waste full
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System status is also displayed on the Status screen. See Status 
screen (page 23) for a description of the Status screen.

• Activity. Shows whether the cytometer power is on and the 
status of acquisition. The following table describes the 
indicator LEDs, and status that triggers them.

Fluid control The three fluid control buttons (RUN, STANDBY, and PRIME) set 
the cytometer operation.

• RUN. Pressurizes the sample tube to transport the sample 
through the sample injection tube and into the flow cell.

The RUN button is green when the sample tube is on and the 
support arm is centered. When the tube support arm is moved 
left or right to remove a sample tube, the cytometer switches to 
an automatic standby status to conserve sheath fluid, and the 
RUN button changes to orange.

The RUN button will also turn orange if the sample tube is 
cracked or the BAL seal is bad. See Troubleshooting 
(page 119).

• STANDBY. Stops fluid flow to conserve sheath fluid.

When you leave the cytometer for more than a few minutes, 
place a tube containing less than 1 mL of deionized (DI) water 
on the sample injection port (SIP) and press STANDBY.

• PRIME. Prepares the fluidics system by draining and filling the 
flow cell with sheath fluid.

Note:  Remove sample tubes during the prime cycle.

The fluid flow initially stops, and pressure is reversed to force 
fluid out of the flow cell and into the waste container. After a 

Indicator LED color Status

Steady pulse blue Cytometer is powered on

Fluctuates blue Cells are passing through the 
flow cell



BD FACSCelesta™ Flow Cytometer User’s Guide22

preset time, the flow cell fills with sheath fluid at a controlled 
rate to prevent bubble formation or entrapment. At 
completion, the cytometer switches to standby mode.

Sample flow rate 
control

The three flow rate control buttons (LOW, MED, HIGH) set the 
sample flow rate through the flow cell. The SAMPLE ADJ buttons 
allow you to adjust the rate to intermediate levels.

When sample adjust is set to 250 (as shown on the status screen on 
the control panel) the sample flow rates at the Low, Med, and High 
settings are approximately 12, 35, and 60 µL/min of sample, 
respectively. Each time you press one of the SAMPLE ADJ buttons, 
the fine adjust of the indicated sample increases or decreases by 10. 

Number Component

1 Status screen

2 Sample flow rate buttons

3 Sample fine adjust buttons

2

1

3



Chapter 2: Introduction 23

The following table shows the approximate sample flow rate range 
for low, medium, and high.

Status screen The status screen line toggles between two different displays and is 
described in detail in the following table.

Settings Sample flow rate (µL/min)

Low 6–24

Med 17.5–70

High 30–120

12

3

4
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Fluidic alarms and 
the Mode button

The fluidic alarms are triggered by the waste and sheath fluid levels 
in the tanks. The alarms sound when the waste tank is nearly 
100% full and the sheath tank is empty. The fluidic alarms and 
system status will also show warnings when you start up the 
cytometer until the tank pressure reaches the correct level.

To silence the alarm, press the MODE button, then press the Down 
button. The MODE button flashes to indicate the cytometer is in 
silent mode. Repeat this sequence to turn off silent mode.

Note:  Turning the cytometer to silent mode may result in overflow 
of waste and you may run out of sheath. 

Note:  When the cytometer is in HTS mode, both visual and 
audible alarms will be deactivated. 

Line Definition

1 Waste level. Shows range from E (empty) to F (full). The 
display line increases from left to right in sequences of 
20%. System status turns yellow at 80%, and red at 100% 
full.

2 Sheath level. Shows range from E to F. The display line 
decreases from right to left in sequences of 20% from full 
level. System status turns yellow at 20%, and red at 0%.

3 Fine Adj. Shows the current setting of fine adjust. Fine 
adjust can be set in increments of 10 from 0 to 500. The 
normal set point is 250. The last value persists, even after 
cytometer shutdown.

4 HTS mode. Shows that the cytometer is in HTS mode. To 
enter this mode, press and hold down the MODE button 
for more than 3 seconds. Status information is not 
displayed and system status turns green. To return to the 
normal mode, press and hold the MODE button for more 
than 3 seconds
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Sample injection 
port (SIP)

The SIP is where the sample tube is installed. The SIP includes the 
sample injection tube and the tube support arm. Samples are 
introduced through a stainless steel injection tube equipped with 
an outer droplet containment sleeve. The sleeve works in 
conjunction with a vacuum pump to eliminate droplet formation 
of sheath fluid as it backflushes from the sample injection tube.

Sample injection tube. Stainless steel tube that carries sample from 
the sample tube to the flow cell. This tube is covered with an outer 
sleeve that serves as part of the droplet containment system.

Tube support arm. Arm that supports the sample tube and 
activates the droplet containment system vacuum. The vacuum is 
on when the arm is positioned to the side and off when the arm is 
centered.

Note:  If a sample tube is left on the SIP with the tube support arm 
to the side (vacuum on), the sample will be aspirated into the waste 
container.

Outer sleeve

Sample injection tube

Tube support arm
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Cautions when 
using the HTS 
option

Droplet 
containment 
module

The DCM prevents sheath fluid from dripping from the SIP and 
provides biohazard protection.

The DCM vacuum is activated when the tube support arm is 
moved to the side. Sheath fluid is aspirated as it backflushes the 
sample injection tube. This backflush helps prevent carryover of 
cells between samples.

Caution: Biohazard! When using the BD FACSCelesta™ 
flow cytometer with the HTS, ensure that the HTS is 
completely pushed into the operating position before 
removing the droplet containment module (DCM) sleeve 
or disconnecting the sample coupler from the SIP. This is 
to avoid accidental leakage of potentially biohazardous 
liquids directly onto the instrument. With the HTS in the 
proper location, the containment dish with padding is 
directly below the SIP.

Caution! If you are using the HTS option, always slide 
the HTS mount slowly to prevent sample cross-
contamination when the wells are full. Never move the 
HTS when it is in operation.

Caution! Do not lean on or put any weight on the HTS as 
it could damage the instrument.



Chapter 2: Introduction 27

Sheath and waste containers
Introduction This topic describes the sheath and waste containers. The sheath 

and waste containers are outside the cytometer and can be 
positioned on the floor.

Note:  Only BD service engineers should change the location of the 
sheath and waste tanks.

If you are using the BD FACSFlow™ supply system (FFSS), see the 
documentation provided.

Sheath container The sheath container has a capacity of 10 L. Sheath fluid is filtered 
through an in-line, interchangeable filter that prevents small 
particles from entering the sheath fluid lines. An alarm sounds 
when the container is empty.

Waste container The waste container has a capacity of 10 L. An alarm sounds when 
the container is full.

More information • Preparing the sheath container (page 33)

• Preparing the waste container (page 38)

• Status screen (page 23)

• Fluidic alarms and the Mode button (page 24)

Caution! Do not fill the sheath tank to its maximum 
capacity. When an overfull tank is pressurized, erratic 
cytometer performance can result.
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Optics
Introduction This topic describes the optical components for the 

BD FACSCelesta™ flow cytometer including:

• Detector arrays

• Laser options

• Optical filters

• Signal detectors

Detector arrays The BD FACSCelesta™ detector arrays consist of polygons. Each 
polygon can be outfitted with two to six fluorescent detectors and 
can detect up to six fluorescent signals.

Laser options The BD FACSCelesta™ flow cytometer can be configured with up 
to three lasers as listed in the following table. 

 

Optical filters Optical filters attenuate light or help direct it to the appropriate 
detectors. The name and spectral characteristics of each filter 
appear on its holder.

There are two types of optical filters in the BD FACSCelesta™:

• Longpass dichroic filters (LPs). Transmit wavelengths at or 
longer than the specified value and reflect all light below the 
specified wavelength.

Laser Wavelength (nm) Power (mW)

Violet (standard) 405 50

Blue (standard) 488 20

UV (optional) 355 15

Yellow Green 
(optional)

561 50

Red (optional) 640 40
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• Bandpass filters (BPs). Pass a narrow spectral band of light.

When dichroic filters are used as steering optics to direct different 
color light signals to different detectors, they are called dichroic 
mirrors. Longpass dichroic mirrors transmit longer wavelengths to 
one detector while reflecting shorter wavelengths to a different 
detector.

The BD FACSCelesta™ flow cytometer polygon detector arrays 
use dichroic longpass mirrors on the inside, and bandpass filters on 
the outside of the filter holders.

Signal detectors Light signals are generated as particles pass through the laser beam 
in a fluid stream. When these optical signals reach a detector, 
electrical pulses are created that are then processed by the 
electronics system.

There are two types of signal detectors in the BD FACSCelesta™ 
flow cytometer: 

• Photomultiplier tubes (PMTs).  Used to detect the weaker 
signals generated by side scatter and all fluorescence channels. 
These signals are amplified by applying a voltage to the PMTs. 

Longpass dichroic mirrors

Bandpass filters
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• Photodiodes.  Less sensitive to light signals than the PMTs. A 
photodiode is used to detect the stronger forward scatter (FSC) 
signal.

More information • Optical filter theory (page 106)

• About the configuration (page 134)

Workstation
Introduction This topic describes the components of the BD FACSCelesta™ 

workstation.

Workstation 
components

Acquisition, analysis, and most instrument functions are controlled 
by the BD FACSCelesta™ workstation. It includes a PC and one or 
two monitors. 

Your workstation is equipped with the following:

• Microsoft Windows operating system

• BD FACSDiva™ software version 8.0.1.1 or later for data 
acquisition and analysis 

• Software documentation including the help system

More information • About the BD FACSCelesta™ documentation (page 11)



3
Cytometer setup

This chapter covers the following topics:

• Starting the cytometer and computer (page 32)

• Preparing the sheath container (page 33)

• Removing air bubbles (page 35)

• Preparing the waste container (page 38)

• Priming the fluidics (page 40)

• About the optical filters and mirrors (page 41)

• Custom configurations and baselines (page 43)
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Starting the cytometer and computer
Introduction This topic describes how to start the cytometer and turn on the 

computer.

Note:  If your system is using the BD FACSFlow™ supply system, 
make sure that the BD FACSFlow™ supply system is powered on 
before the cytometer.

Procedure To start the cytometer:

1. Turn on the power to the flow cytometer. 

Allow 30 minutes for the optical system temperature to 
stabilize.

2. Turn on the computer and log in to Windows.

Note:  You can turn on the power to the flow cytometer and 
the workstation in any order.

3. Start BD FACSDiva™ software by double-clicking the shortcut 
on the desktop, and log in to the software.

4. Check the Cytometer window in BD FACSDiva™ software to 
ensure that the cytometer is connected to the workstation.

The cytometer connects automatically. While connecting, the 
message Cytometer Connecting is displayed in the status area 
of the Cytometer window. When connection completes, the 
message changes to Cytometer Connected.

Caution! Failure to warm up and stabilize the 
instrument could affect sample data.
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If the message Cytometer Disconnected appears, see 
Electronics troubleshooting (page 128).

Preparing the sheath container
Introduction This topic describes how to prepare the sheath container. 

Note:  If your system is using the BD FACSFlow™ supply system, 
see the documentation provided with your system.

When to check the 
sheath container

Check the fluid levels in the sheath container every time you use 
the cytometer. This ensures that you do not run out of sheath fluid 
during an experiment.
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Sheath container 
components

Procedure To prepare the sheath container:

1. Verify that the flow cytometer is in standby mode. 

Press the STANDBY button on the control panel if necessary.

2. Disconnect the green air line and blue sheath fluid line from 
the sheath container.

3. Disconnect the alarm line from the alarm sensor socket by 
pulling lightly on both ends of the plug.

4. Depressurize the sheath container by pulling up on the vent 
valve.

Air line (green)

Alarm Sensor

Clamp Knob

Vent Valve

Cap handle 

Filter assembly

Sheath fluid 
line (blue) to 
cytometer
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5. Remove the sheath container lid. 

Unscrew the clamp knob and push down to loosen, if 
necessary. Tilt the cap to the side to remove it from the tank.

6. Add up to 10 L of sheath fluid, such as BD FACSFlow™ 
solution, to the sheath container. 

Note:  10 L will reach the interior line on the sheath tank. Do 
not fill the sheath tank further.

7. Replace the sheath container lid. 

8. Make sure the gasket on the inside lip of the sheath lid is 
seated correctly and has not slipped out of position.

Note:  If the gasket is not seated correctly, the tank will not 
pressurize properly.

9. Close the sheath lid and tighten the clamp knob to finger-tight. 

10. Reconnect the green air line, alarm line and the blue sheath 
line.

Note:  Ensure that the blue sheath fluid line is not kinked.

More information • Removing air bubbles (page 35)

• Changing the sheath filter (page 55)

• Cleaning or replacing the sheath gasket (page 61)

Removing air bubbles
Introduction This topic describes how to remove trapped air bubbles in the 

sheath filter and the sheath line. Air bubbles can occasionally 
dislodge and pass through the flow cell, resulting in inaccurate 
data.

Note:  Perform this activity every time the sheath tank is refilled. 
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Procedure To remove air bubbles:

1. Check the sheath filter for trapped air bubbles.

2. If bubbles are visible, gently tap the filter body with your 
fingers to dislodge the bubbles and force them to the top.

Caution! When removing air bubbles, do not 
vigorously shake, bend, or rattle the sheath filter or 
you might damage it.

Vent line

Vent fitting

Cytometer fluid line 
(roller clamp not visible)
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3. Direct the vent line into a beaker and press the small button at 
the end of the vent fitting against the side of the beaker until a 
steady stream of fluid empties from the filter.

4. Tilt the filter and verify that no trapped air remains in the 
filter. 

5. Repeat steps 3 and 4 until no air is observed in the filter.

6. Check the sheath line for air bubbles.

7. Open the roller clamp at the fluidics interconnect (if necessary) 
to bleed off any air in the line. Collect any excess fluid in a 
waste container.

Note:  The roller clamp can be found close to the fluidics ports 
of the cytometer.

8. Close the roller clamp.

Button

Vent fitting
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Preparing the waste container
Introduction This topic describes how to prepare the waste container. Prevent 

waste overflow by emptying the waste container daily or whenever 
the system status indicator turns yellow.

Note:  If your system is connected to the FFSS, see the 
documentation provided with your FFSS.

Waste container 
components

The following figure shows the main components of the waste 
container.

Caution: Biohazard! All biological specimens and 
materials coming into contact with them are considered 
biohazardous. Handle as if capable of transmitting 
disease. Dispose of waste using proper precautions and in 
accordance with local regulations. Never pipette by 
mouth. Wear suitable protective clothing, eyewear, and 
gloves.

Moisture trap

Alarm sensor

Air line

Waste fluid 
line 

User replaceable cap 
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Biological 
precautions

To prevent exposure to biohazardous agents:

• Put the cytometer in standby mode before disconnecting the 
waste tank to avoid leakage of biohazardous waste.

• Always disconnect the waste container from the cytometer 
before you empty it. Wait at least 30 seconds for pressure to 
dissipate before you remove the waste cap or sensor.

• Expose waste container contents to bleach (10% of total 
volume) for 30 minutes before disposal.

• Do not wet the waste tank cap. If wet, the filter in the cap will 
cause the tank to malfunction. To keep the cap dry, place it on 
the bench label side up when it is not on the tank. 

Procedure To prepare the waste container:

1. Verify that the flow cytometer is in standby mode. 

Press the STANDBY button on the control panel if necessary.

2. Disconnect the orange waste tubing from the waste container. 

3. Disconnect the black alarm sensor line from the alarm sensor 
socket.

Keep the lid and moisture trap on the waste container until 
you are ready to empty it.

4. Remove the lid and moisture trap before emptying the waste 
container. Keep the cap label side up at all times. Empty the 
waste container.

5. Add approximately 1 L of bleach to the waste container and 
close it. Reattach the moisture trap and lid.

Caution: Biohazard! Contact with biological specimens 
and materials can transmit potentially fatal disease.

Caution! The waste container is heavy when full. 
When emptying it, use good body mechanics to 
prevent injury.
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6. Reconnect the orange waste tubing and make sure it is not 
kinked.

7. Reconnect the black alarm sensor line.

Priming the fluidics
Introduction This topic describes how to prime the fluidics system.

When to prime the 
fluidics

Sometimes, air bubbles and debris may become lodged in the flow 
cell. This is indicated by excessive noise in the forward and side 
scatter parameters (FSC and SSC, respectively). In these cases, it is 
necessary to prime the fluidics system.

Procedure To prime the fluidics:

1. Move the tube support arm to the side.

2. Remove the tube from the SIP.

3. Press the PRIME fluid control button to force the fluid out of 
the flow cell and into the waste container.

Once drained, the flow cell automatically fills with sheath fluid 
at a controlled rate to prevent bubble formation or 
entrapment. The STANDBY button turns amber after 
completion.

4. Repeat the priming procedure, if necessary.

5. Install a 12 x 75-mm tube with less than 1 mL of DI water on 
the SIP and place the support arm under the tube. Leave the 
cytometer in standby mode.

More information • Cytometer troubleshooting (page 120)
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About the optical filters and mirrors
Introduction This topic provides a description of the optical filters and mirrors.

Filter and mirror 
configurations

Each detector has an optic holder in front of it. The optic holders 
are labeled with numbers indicating the wavelengths of the 
bandpass filter and longpass dichroic mirror they contain (for 
example, 780/60 and 750 LP, respectively). The optic holder in 
front of the last detector in the detector array contains only a 
bandpass filter and is marked accordingly.

The filters steer progressively shorter wavelengths of light to the 
next detector in the array as indicated by the lines and arrows on 
the top of the polygon.

Optic holders, 
filters, and mirrors

Optic holders house filters and mirrors. Your cytometer includes 
several blank (empty) optic holders. 

3

PMT A

Optic holder 
handle

Optic holders

Caution! To ensure data integrity, do not leave any slots 
empty in a detector array when you are using the 
associated laser. Always use a blank optic holder.

Caution! Do not remove or change filters. Only BD 
authorized personnel should remove or change the filters.
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Base configurations Each BD FACSCelesta™ flow cytometer has a base cytometer 
configuration that corresponds to the layout of the installed lasers 
and optics in your cytometer. This base configuration is set by your 
field service engineer.

BD FACSDiva™ 
cytometer 
configuration

Before you acquire data using BD FACSDiva™ software, you must 
specify a cytometer configuration. The cytometer configuration 
defines which filters and mirrors are installed at each detector.

BD FACSDiva™ software provides a BD base configuration for 
your BD FACSCelesta™ flow cytometer. Select Cytometer > 
View Configuration to create, modify, or delete custom cytometer 
configurations. (See the Cytometer and Acquisition Controls 
chapter of the BD FACSDiva™ Software Reference Manual for 
details.)

More information • About the configuration (page 134)
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Custom configurations and baselines
Introduction This topic describes where to find information on how to create a 

custom configuration and define a baseline for a performance 
check.

Overview BD Cytometer Setup and Tracking (CS&T) software is used to 
define the baseline performance of your cytometer. A baseline 
provides a starting point for the tracking of cytometer 
performance. When running a performance check, you compare 
the results to the baseline.

See Optimizing cytometer settings (page 63). Please see the latest 
published filter guides available on our website 
(bdbiosciences.com) for more information. 

See the BD Cytometer Setup and Tracking Application Guide for 
information on creating custom configurations and defining a 
baseline.

More information • Running a performance check (page 69)

http://www.bdbiosciences.com
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4
Maintenance

This chapter covers the following topics:

• Maintenance overview (page 46)

• Cleaning the fluidics (page 47)

• Shutting down the cytometer (page 49)

• Flushing the system (page 50)

• Replacing the waste container cap (page 53)

• Changing the sheath filter (page 55)

• Changing the Bal seal (page 57)

• Changing the sample tube O-ring (page 59)

• Cleaning or replacing the sheath gasket (page 61)
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Maintenance overview
Introduction This topic provides an overview of the BD FACSCelesta™ flow 

cytometer routine maintenance and cleaning procedures.

General use 
guidelines

Follow these guidelines whenever operating or maintaining the 
cytometer:

• Wear suitable protective clothing, eyewear, and gloves.

• Handle all biological specimens and materials in accordance 
with applicable regulations and manufacturer specifications.

• Dispose of waste using proper precautions and in accordance 
with local regulations.

• Never pipette by mouth.

For fluidics maintenance, we recommend the following cleaning 
solutions: 

• BD FACSClean™ solution

• 1.5% BD Detergent Solution Concentrate 

• 10% bleach solution

Use DI water to dilute bleach to appropriate concentrations. 

Caution: Biohazard! Contact with biological specimens 
and materials can transmit potentially fatal disease. 

Caution! Higher concentrations of bleach and use of 
other cleaning solutions might damage the cytometer.
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When to perform 
maintenance 
procedures

Perform maintenance procedures in the following frequencies.

Cleaning the fluidics
Introduction This topic describes how to perform the daily fluidics cleaning.

Overview Cleaning the fluidics daily prevents the sample injection tube from 
becoming clogged and removes dyes that can remain in the tubing. 

In addition to daily cleaning, follow this procedure immediately 
after running viscous samples or nucleic acid dyes such as Hoechst, 
DAPI, propidium iodide (PI), acridine orange (AO), or thiazole 
orange (TO).

Procedure To clean the fluidics:

1. Press RUN and HIGH on the cytometer fluid control panel. 

2. Install a tube containing 3 mL of a 10% bleach solution on the 
SIP with the support arm to the side (vacuum on) and let it run 
for 1 minute.

Frequency Maintenance procedure

Daily  Cleaning the fluidics (page 47)

 Shutting down the cytometer (page 49)

Scheduled (every 
two weeks)

 Flushing the system (page 50)

Periodic (frequency 
depends on how 
often you run the 
cytometer)

 Changing the sheath filter (page 55)

 Changing the Bal seal (page 57)

 Changing the sample tube O-ring (page 59)

 Cleaning or replacing the sheath gasket 
(page 61)
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See Maintenance overview (page 46) for other recommended 
cleaning solutions.

3. Move the tube support arm under the tube (vacuum off) and 
allow the cleaning solution to run for 5 minutes with the 
sample flow rate set to HIGH.

4. Repeat steps 2 and 3 with DI water.

5. Repeat steps 2 and 3 with 1.5% dilution of  BD Detergent 
Solution Concentrate. 

Note:  The BD Detergent Solution Concentrate must be diluted 
before use. Mix one full 15 mL bottle of BD Detergent 
Solution Concentrate into 985 mL of DI water to make 1 L 
total.

6. Repeat steps 2 and 3 with DI water.

7. Press the STANDBY button on the fluidics control panel.

8. Place a tube containing less than 1 mL of DI water on the SIP.

A tube with less than 1 mL of DI water should remain on the 
SIP to prevent salt deposits from forming in the injection tube. 
This tube also catches back drips from the flow cell.

Caution: Biohazard! Do not mix BD Detergent Solution 
Concentrate and bleach because they produce chlorine 
gas.

Caution! Do not leave more than 1 mL of water on 
the SIP. When the instrument is turned off or left in 
standby mode, a small amount of fluid will drip back 
into the sample tube. If there is too much fluid in the 
tube, it could overflow and affect the cytometer 
performance.
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Shutting down the cytometer
Introduction This topic describes how to shut down the cytometer. 

Before you begin Each time you shut down the cytometer, perform the daily cleaning 
as described in Cleaning the fluidics (page 47).

Procedure To shut down the cytometer:

1. Place a tube of DI water on the SIP.

2. Turn off the flow cytometer.

3. Close FACSDiva™ software.

4. Select Start > Shutdown to turn off the computer (if needed).

5. If your system is connected to the FFSS, shut off the FFSS.

If the cytometer will not be used for a week or longer, perform a 
system flush and leave the fluidics system filled with DI water to 
prevent saline crystals from clogging the fluidics.

More information • Cleaning the fluidics (page 47)

• Flushing the system (page 50)
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Flushing the system
Introduction This topic describes how to perform an overall fluidics cleaning to 

remove debris and contaminants from the sheath tubing, waste 
tubing, and flow cell. Perform the system flush at least every 2 
weeks.

Note:  If you are using the BD FACSFlow™ supply system, see the 
BD FACSFlow™ Supply System User’s Guide for instructions on 
flushing the system.

Cautions

Procedure To perform a system flush:

1. Remove the sheath filter.

a. Press the quick-disconnects on both sides of the filter 
assembly.

b. Remove the filter assembly.

c. Connect the two fluid lines.

2. Empty the sheath container and rinse it with DI water.

3. Fill the sheath container with at least 1 L of BD FACSClean 
solution.

4. Empty the waste container, if needed.

5. Open the roller clamp by the fluidics interconnect, and drain 
the fluid into a beaker for 5 seconds.

Caution: Biohazard! The cytometer hardware might be 
contaminated with biohazardous material. Use 10% 
bleach to decontaminate the instrument. 

Caution! Do not run detergent, bleach, or ethanol 
through the sheath filter. They can break down the 
filter paper within the filter body, causing particles to 
escape into the sheath fluid, possibly clogging the 
flow cell.
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6. Remove the DI water tube from the SIP.

7. Prime the instrument twice:

a. Press the PRIME button on the fluidics control panel. 

b. When the STANDBY button light is amber, press the 
PRIME button again.

8. Install a tube with 3 mL of BD FACSClean solution on the SIP 
and put the tube support arm underneath the tube.

See Maintenance overview (page 46) for other recommended 
cleaning solutions.

9. Press RUN and HIGH on the cytometer fluid control panel. 
Ensure that the sample fine adjust is set to 250. Run for 30 
minutes.

10. Press the STANDBY fluid control button and depressurize the 
sheath container by lifting the vent valve.

11. Empty the waste tank to avoid the mixing of Bleach and BD 
Detergent Solution.

12. Repeat steps 2 through 11 with DI water.

13. Repeat steps 2 through 11 with 1.5% dilution of BD Detergent 
Solution Concentrate.

Note:  The BD Detergent Solution Concentrate must be diluted 
before use. Mix one full 15 mL bottle of BD Detergent 
Solution Concentrate into 985 mL of DI water to make 1 L 
total.

14. Repeat steps 2 through 11 with DI water.

15. Replace the sheath filter and refill the sheath container with 
sheath fluid.

Caution: Biohazard! Do not mix BD Detergent Solution 
Concentrate and bleach because they produce chlorine 
gas.
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16. Install a tube with less than 1mL DI water onto the SIP.
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Replacing the waste container cap
Introduction This topic describes how to replace the waste container cap. 

Replace the cap once a month.

Biological 
precautions

To prevent exposure to biohazardous agents:

• Put the cytometer in standby mode before disconnecting the 
waste tank to avoid leakage of biohazardous waste.

• The waste container can become pressurized when the 
cytometer is running. Always disconnect the waste container 
from the cytometer before you empty it. Wait at least 
30 seconds for pressure to dissipate before you remove the 
waste cap or sensor.

• Expose waste container contents to bleach (10% of total 
volume) for 30 minutes before disposal.

Procedure To replace the cap:

1. Put the cytometer in standby mode.

2. Disconnect the orange waste line from the waste container 
tank.

3. Disconnect the alarm sensor line from the alarm sensor socket.

Note:  Wait at least 30 seconds for pressure to dissipate.

4. Remove the waste cap and attached trap from the container 
and place on the bench label-side up.

5. Detach the cap from the trap.

6. Place a new cap on the trap.

Caution: Biohazard! Contact with biological specimens 
and materials can transmit potentially fatal disease.
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7. Write the date on the cap label.

8. Screw the cap assembly onto the waste container and hand-
tighten until it is fully closed.

Re-attach the alarm sensor line and waste line to the waste 
container tank.

Caution: Biohazard! To prevent waste container 
overpressurization, do not overtighten the trap or 
attached filter cap. Tighten each component only until it 
is hand-tight. Do not use sealants such as Teflon® tape 
or other adhesives.

338677 Rev A

Waste (A)

Space for date
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Changing the sheath filter
Introduction This topic describes how to change the sheath filter. The sheath 

filter is connected in-line with the sheath line. It filters the sheath 
fluid as it comes from the sheath container. 

When to change 
the sheath filter

We recommend changing the sheath filter assembly every 
six months. Increased debris appearing in an FSC vs SSC plot can 
indicate that the sheath filter needs to be replaced. See Supplies and 
consumables (page 145) for ordering information.

Sheath filter 
components

Filter base

Quick-disconnect

Sheath line

Vent fitting

Vent line
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Removing the old 
filter

To remove the old filter:

1. Place the cytometer in standby mode.

2. Remove the sheath filter assembly by pressing the 
quick-disconnect on both sides of the filter assembly.

3. Over a sink or beaker:

• Remove the vent line from the filter and set it aside.

• Remove the filter base and set it aside.

4. Discard the used filter assembly in an appropriate receptacle.

Attaching the new 
filter

To attach the new filter:

1. Connect the vent line to the new filter assembly.

Twist to attach.

2. Wrap Teflon® tape around the filter threads, then connect the 
filter to the filter base.

3. Connect the sheath line to the filter assembly by squeezing the 
quick-disconnect.

4. Attach the cytometer fluid line to the filter assembly via the 
quick-disconnect.

5. Direct the vent line into a beaker and press the small button at 
the end of the vent fitting against the side of the beaker until a 
steady stream of fluid empties from the filter.

6. Tilt the filter and verify that no trapped air remains in the 
filter.

7. Repeat steps 5 and 6 as necessary to remove all trapped air.
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Changing the Bal seal
Introduction This topic describes how to replace the Bal seal. 

The sample injection tube Bal seal is a ring thaft forms a seal with 
the sample tube and ensures proper tube pressurization. 

When to change 
the Bal seal

Over time, the Bal seal becomes worn or cracked and requires 
replacement. Replacement is necessary if a proper seal is not 
formed when a sample tube is installed on the SIP. Indications that 
a proper seal has not formed include:

• The tube will not stay on the SIP without the tube support 
arm.

• When the tube is installed and RUN is pressed on the 
cytometer, the RUN button is orange (not green).

Caution

Procedure To replace the Bal seal:

1. Remove the outer sleeve from the sample injection tube by 
turning the retainer counter-clockwise. Slide the outer sleeve 
down and off of the sample injection tube.

Caution: Biohazard! Cytometer hardware might be 
contaminated with biohazardous material. Wear suitable 
protective clothing, eyewear, and gloves whenever 
cleaning the cytometer or replacing parts.
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Work carefully. The outer sleeve can fall off as you loosen the 
retainer.

2. Remove the Bal seal by gripping it between your thumb and 
index finger and pulling down.

3. Install the new Bal seal spring-side up.

Ensure that the sample tube O-ring is still in place inside the 
retainer. 

Retainer

Outer sleeve

Sample injection tube

Bal seal
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4. Re-install the retainer and outer sleeve over the sample 
injection tube. Push the outer sleeve all the way up into the 
sample injection port and then screw the retainer into place 
and tighten to finger tight. This will seat the Bal seal.

5. Install a sample tube on the SIP to ensure that the outer sleeve 
has been properly installed. 

If the sleeve hits the bottom of the tube, loosen the retainer 
slightly and push the sleeve up as far as it will go. Tighten the 
retainer.

Changing the sample tube O-ring
Introduction This topic describes how to replace the sample tube O-ring.

The sample tube O-ring, located within the retainer, forms a seal 
that allows the droplet containment vacuum to function properly. 

When to replace 
the O-ring

Replace the O-ring when droplets form at the end of the sample 
injection tube while the vacuum is operating.

Caution

Procedure To change the O-ring:

1. Remove the outer sleeve from the sample injection tube by 
turning the retainer counter-clockwise.

Caution: Biohazard! Cytometer hardware might be 
contaminated with biohazardous material. Wear suitable 
protective clothing, eyewear, and gloves whenever 
cleaning the cytometer or replacing parts.
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2. Slide the outer sleeve from the retainer.

3. Invert the outer droplet sleeve and allow the O-ring to fall 
onto the benchtop. 

If the O-ring does not fall out initially, hold the O-ring with 
your free hand and slide the outer sleeve to remove the O-ring.

4. Place the new O-ring into the retainer. Make sure the O-ring is 
seated properly in the bottom of the retainer.

5. Replace the outer sleeve in the retainer.

6. Re-install the retainer and the outer sleeve.

7. Install a sample tube on the SIP to ensure that the outer sleeve 
has been properly installed. 

If the sleeve hits the bottom of the tube, loosen the retainer 
slightly and push the sleeve up as far as it will go. Tighten the 
retainer.

Retainer

O-ring
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Cleaning or replacing the sheath gasket 
Introduction This topic describes how to clean or replace the gasket of the 

sheath tank lid.

When to change 
the sheath gasket

We recommend cleaning the sheath gasket when needed.

Procedure To clean or replace the gasket:

1. Put the cytometer in standby mode.

2. Depressurize the sheath container by pulling up on the vent 
valve.

3. Remove the lid from the sheath tank. 

4. Remove the black gasket from the lid. 

5. Rinse it with water to clean the gasket. 

6. Place the clean gasket or the new gasket on the lid and make 
sure the gasket is seated properly on the lid. 
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5
Optimizing cytometer settings

This chapter covers the following topics:

• Cytometer settings workflow (page 64)

• Verifying the configuration and user preferences (page 66)

• Running a performance check (page 69)

• Setting up an experiment (page 74)

• Creating application settings (page 79)

• Recording compensation controls (page 82)

• Calculating compensation (page 85)
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Cytometer settings workflow
Introduction This topic describes how to optimize cytometer settings. The 

optimization is performed using the Cytometer Setup and 
Tracking, Application Settings, and Compensation Setup features 
of BD FACSDiva™ software. 

When to optimize 
settings

Before you record data for a sample, optimize the cytometer 
settings for the sample type and fluorochromes used. 

Manual 
compensation

Compensation setup automatically calculates compensation 
settings. If you choose to perform compensation manually, not all 
of the following instructions apply. For detailed instructions, see 
the BD FACSDiva™ Software Reference Manual.

First-time users If you are performing the procedures in this workflow for the first 
time, you should be familiar with BD FACSDiva™ software 
concepts: workspace components, cytometer and acquisition 
controls, and tools for data analysis.

For additional details, see the BD FACSDiva™ Software Reference 
Manual.

Before you begin Start the BD FACSCelesta™ flow cytometer and perform the setup 
and QC procedures. See Cytometer setup (page 31).

Workflow for 
optimizing settings

Cytometer optimization consists of the following steps.

Step Description

1 Verifying the configuration and user preferences (page 66)

2 Running a performance check (page 69)

3 Setting up an experiment (page 74)
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Note:  Application settings are optional and do not have to be 
saved for the experiments. However, they are useful for optimizing 
cytometer settings.

About the 
examples

The examples in this chapter use a 4-color bead sample with the 
following fluorochromes:

• FITC

• PE

• PerCP-Cy5.5

• APC

If you follow this workflow with a different bead sample (or 
another sample type), your software views, data plots, and 
statistics might differ from the example. Additionally, you might 
need to modify some of the instructions in the procedure.

The information shown in italics is for example only. You can 
substitute your own names for folders and experiments.

4 Creating application settings (page 79)

5 Recording compensation controls (page 82)

6 Calculating compensation (page 85)

Step Description
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Verifying the configuration and user preferences
Introduction This topic describes how to verify the cytometer configuration and 

user preferences before you create an experiment.

Procedure To verify the configuration and preferences before you create an 
experiment:

1. Select Cytometer > View Configurations and verify the current 
configuration. 

Caution! To obtain accurate data results, the current 
cytometer configuration must reflect your 
BD FACSCelesta™ flow cytometer optics. 
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Your cytometer might include only the base configuration 
when your cytometer is installed. You can create additional 
configurations later as needed. 
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In this example, the cytometer configuration must include the 
following parameters: FITC, PE, PerCP-Cy5.5, and APC.

2. If you need to select a configuration other than the current 
configuration:

a. In the Configurations tab, select a configuration. 

b. Click Set Configuration.

c. Click OK. 

d. Verify that the configuration you just set matches your 
BD FACSCelesta™ flow cytometer optics.

3. Click OK to close the Cytometer Configuration window.

4. Select File > Exit to close CS&T.

5. Select Edit > User Preferences. 

6. Click the General tab and select the Load data after recording 
checkbox.

See the BD FACSDiva™ Software Reference Manual for more 
information about cytometer configurations and user preferences.

Next step Running a performance check (page 69)

More information • Setting up an experiment (page 74)
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Running a performance check
Introduction This topic describes how to run a performance check as part of 

quality control.

Overview The CS&T application is designed to monitor performance on a 
daily basis and to optimize laser delay. 

Running a performance check on a regular basis provides a 
standard for monitoring changes in performance due to 
degradation of laser power, aging of PMTs, and other potential 
cytometer service issues. Performance results are also affected by 
fluidics performance. We strongly recommend following the 
fluidics maintenance procedures as described in Cleaning the 
fluidics (page 47).

Considerations Some BP filters might not be normalized to CS&T settings. In this 
case, CS&T will generate Qr and Br numbers that are not 
comparable from instrument to instrument. They are however, still 
trackable on one cytometer. Part of the process for optimizing 
cytometer settings includes verifying PMT voltages set by CS&T 
for all parameters. Carefully examine any channel with a non-
CS&T normalized filter. If the baseline settings are not appropriate 
for your applications, adjust the PMT voltage as necessary and use 
the Application Settings to maintain Target Values.

Before you begin Define the performance baseline for any configuration before 
running a performance check. See Custom configurations and 
baselines (page 43).
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Procedure To run a performance check:

1. Select Cytometer > CST.

2. Verify that the bead lot information under Setup Beads 
matches the Cytometer Setup and Tracking bead lot.

3. Verify that the cytometer configuration is correct for your 
experiment.

If the cytometer is not set to the correct configuration:

a. Click Select Configuration in the Setup Control window.

b. Select the correct configuration from the list.

c. Click Set Configuration and then click OK.

4. Verify that the current configuration has a valid baseline 
defined.

If not, see the BD Cytometer Setup and Tracking Application 
Guide for more information on defining a baseline.

5. Prepare the CS&T beads according to the technical data sheet 
provided with the beads or available on the BD Biosciences 
website (bdbiosciences.com).

6. Install the bead tube onto the SIP.

http://www.bdbiosciences.com
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7. In the Setup Control window, select Check Performance from 
the Characterize menu.

8. Click Run.

9. Ensure that Fine Adjust is set to 250, press RUN, and LOW.

Plots appear under the Setup tab and the performance check is 
run. The performance check takes approximately 5 minutes to 
complete.

10. Once the performance check is complete, click View Report.

11. Verify that the cytometer performance passed.

In the Setup tab, the cytometer performance results should 
have a green checkbox displayed and the word Passed next to 
it.
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If any parameters did not pass, see the BD Cytometer Setup 
and Tracking Application Guide for troubleshooting 
information.

12. Select File > Exit to close the CS&T window and return to the 
BD FACSDiva™ interface.

The CST Mismatch dialog opens.

Click the Details button to verify which cytometer settings will 
be updated.

13. Click Use CST Settings.
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By selecting Use CST Settings, the laser delay, area scaling, and 
other cytometer settings will be updated to the latest settings 
from the performance check.

Next step Continue the optimization of your cytometer for an experiment or 
sample type as described in Setting up an experiment (page 74).
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Setting up an experiment
Introduction This topic describes how to create an experiment in a new folder, 

specify the parameters of the experiment, and add compensation 
tubes.

Creating an 
experiment

To create an experiment:

1. Click the buttons on the Workspace toolbar to display the 
following windows as needed:

• Browser 

• Cytometer 

• Inspector 

• Worksheet 

• Acquisition Dashboard 

When you add elements or make selections in the Browser, the 
Inspector displays details, properties, and options that 
correspond to your selection.

2. Click the New Folder button on the Browser toolbar to add a 
new folder. 

3. Click the folder and rename it MyFolder.

4. Click MyFolder, then click the New Experiment button on the 
Browser toolbar. 

a. Click the new experiment in the Browser and rename it 
MyExperiment.
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5. Select MyExperiment in the Browser. 

The Inspector displays details for the experiment. 

Specifying 
parameters

To specify the parameters for the new experiment:

1. Select Cytometer Settings for the experiment in the Browser.

Cytometer settings appear in the Inspector.
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2. Make sure the parameters you need appear on the Parameters 
tab in the Inspector.

If more than one parameter is available for a particular 
detector, you might have to select the one you need from a 
menu. For example, you can set Detector D for the blue laser 
as FITC or BB515.

a. Click the Parameter name to display the available 
fluorochromes in the Parameters list. 
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b. Select the specific parameter from the menu. Your selection 
appears as the selected parameter.

c. For this example, select FITC from the menu.

3. Delete any unnecessary parameters.
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a. Click the selection button (to the left of the parameter 
name) to select the parameter.

b. Click Delete. 

The parameter is deleted.
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Creating application settings
Introduction This topic describes how to create application settings.

About application 
settings

Application settings are associated with a cytometer configuration 
and include the parameters for the application, area scaling values, 
PMT voltages, and threshold values, but not compensation. Each 
time a performance check is run for a configuration, the 
application settings associated with that configuration are updated 
to the latest run.

Using application settings provides a consistent and reproducible 
way to reuse cytometer settings for commonly used applications.

Before you begin Perform the cytometer setup procedure and run a performance 
check for the configuration that will be used for the application.

Procedure To create application settings:

1. In the open experiment, right-click Cytometer Settings in the 
Browser, then select Application Settings > Create Worksheet.

A second global worksheet is added with the plots created 
according to the selections in the Parameters tab. 

2. Load the unstained control tube onto the cytometer.
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3. In the Cytometer window, optimize the PMT voltages for the 
application.

• Optimize the FSC and SSC voltages to place the population 
of interest on scale.

• Optimize the FSC threshold value to eliminate debris 
without interfering with the population of interest.

• If needed, increase the fluorescence PMT voltages to place 
the negative population appropriately for your sample 
type.

Note:  Do not decrease the fluorescence PMT voltages. Doing 
so can make it difficult to resolve dim populations from the 
negative population.

4. Unload the unstained control tube from the cytometer.

5. Load the multicolor sample onto the cytometer or load single-
color control tubes and verify each fluorochrome signal 
separately.
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6. Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for 
that parameter until the positive population can be seen 
entirely on scale.

7. Unload the multicolor sample.

8. Place a tube containing less than 1 mL DI water on the SIP and 
put the cytometer on standby.

9. (Optional) Save the application settings by right-clicking 
Cytometer settings in the Browser, then selecting Application 
Settings > Save.

10. In the Save Application Settings dialog, enter a descriptive 
name for the application settings.

11. Click OK.

The application settings are saved to the catalog.

Next step Recording compensation controls (page 82)
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Recording compensation controls
Introduction This topic describes how to create and record compensation 

controls using the Compensation Setup feature of BD FACSDiva™ 
software and an experiment with optimized settings.

Creating 
compensation 
tubes

To create compensation control tubes:

1. Select Experiment > Compensation Setup > 
Create Compensation Controls.

The Create Compensation Controls dialog opens.

For this bead example, you do not need to provide non-generic 
tube labels.

2. Click OK.
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Compensation control tubes are added to the experiment. 
Worksheets containing appropriate plots and gates are added 
for each compensation tube.

Recording 
compensation 
settings

To record compensation settings:

1. Press RUN and HIGH on the cytometer fluid control panel.

2. Install the unstained control tube onto the SIP. 

3. Expand the Compensation Controls specimen in the Browser.

4. Set the current tube pointer to the unstained control tube (it 
becomes green), then click Acquire Data in the Acquisition 
Dashboard.

5. Verify that the population of interest is displayed appropriately 
on the FSC vs SSC plot and adjust voltages if necessary.
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Since the application settings have been optimized for your 
sample, the cytometer settings should not require adjustment 
other than the changing of FSC and SSC voltages to place the 
beads on scale.

6. Adjust the P1 gate to surround only the singlets.

7. Right-click the P1 gate and select Apply to All Compensation 
Controls. 

The P1 gate on each stained control worksheet is updated with 
your changes.

8. Click Record Data.

9. When recording is finished, remove the unstained control tube 
from the cytometer.

10. Click Next Tube.

11. Install the next tube onto the cytometer and repeat steps 8 
through 10 until data for all stained control tubes has been 
recorded.

12. Double-click the first stained control tube to display the 
corresponding worksheet.

Caution! Do not change the PMT voltages after the 
first compensation control has been recorded. In 
order to calculate compensation, all controls must 
be recorded with the same PMT voltage settings. If 
you need to adjust the PMT voltage for a 
subsequent compensation control, you must record 
all compensation controls again.
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13. Verify that the snap-to interval gate encompasses the positive 
population.

14. Repeat steps 12 and 13 for the remaining compensation tubes.

Next step After you have recorded data for each single-stained control, 
calculate compensation as described in Calculating compensation 
(page 85).

Calculating compensation
Introduction This topic describes how to calculate compensation.

Before you begin Before you can calculate compensation, you need to record the 
data for each single-stained control.

Procedure To calculate compensation:

1. Select Experiment > Compensation Setup > Calculate 
Compensation.

Note:  If the calculation is successful, a dialog prompts you to 
enter a name for the compensation setup. The default name is 
year/month/day/time.
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2. Enter a setup name and click Link & Save.

The compensation is linked to the cytometer settings and saved 
to the catalog.

To help track compensation setups, include the experiment 
name, date, or both in the setup name.

The compensation setup is linked to the MyExperiment 
cytometer settings, and subsequent acquisitions in 
MyExperiment are performed with the new compensation 
settings.

We recommend that you always visually and statistically inspect 
automatically calculated spectral overlap values. The medians of 
the positive controls should be aligned with the medians of the 
negative controls.

More information • Recording compensation controls (page 82)



6
Recording and analyzing data

This chapter covers the following topics:

• Data recording and analysis workflow (page 88)

• Preparing the workspace (page 89)

• Recording data (page 90)

• Analyzing data (page 93)

• Reusing an analysis (page 99)
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Data recording and analysis workflow
Introduction This topic outlines the basic acquisition and analysis tasks using 

BD FACSDiva™ software.

About the 
examples

The examples in this chapter are from two 4-color bead samples 
with the following fluorochromes:

• FITC

• PE

• PerCP-Cy5.5

• APC

If you use a different sample type or if you have skipped the 
optimization steps in Optimizing cytometer settings (page 63), 
your software window content, names of folders and experiments, 
and your data plots and statistics might differ from those shown 
here. You might also need to modify some of the instructions in the 
procedure.

For additional details on completing some of the following steps, 
see the BD FACSDiva™ Software Reference Manual.

This procedure builds on the results obtained in Optimizing 
cytometer settings (page 63).

Workflow for 
recording and 
analyzing data

Recording and analyzing data consists of the following steps.

Step Description

1 Preparing the workspace (page 89)

2 Recording data (page 90)

3 Analyzing data (page 93)

4 Reusing an analysis (page 99)
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Preparing the workspace
Introduction This topic describes how to prepare the workspace and apply 

application settings to your experiment before recording data.

Procedure To prepare the workspace:

1. Using the Browser toolbar, create a new specimen in 
MyExperiment and rename it FourColorBeads.

2. Create two tubes for the FourColorBeads specimen. Rename 
the tubes Beads_001 and Beads_002.

3. Expand the Global Worksheets folder in MyExperiment to 
access the default global worksheet, and rename the worksheet 
MyData.

4. On the MyData worksheet, create the following plots for 
previewing the data:

• FSC vs SSC

• FITC vs PE

• FITC vs PerCP-Cy5.5

• FITC vs APC

Applying saved 
application settings 
to a new 
experiment

When applications settings are applied to an experiment, the 
cytometer settings are updated with the parameters included in the 
application settings, optimized PMT voltages, threshold settings, 
area scaling factors, and window extension values.

To apply saved application settings to your experiment:

1. Right-click the experiment-level Cytometer Settings and select 
Application Settings > Apply.
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2. In the Application Settings catalog, select the application 
settings file you saved previously and click Apply.

If the parameters are not the same, a mismatch dialog opens. 

• Click Overwrite to update all settings.

• Click Apply to change only the common parameters.

For more information, see the BD FACSDiva™ Software 
Reference Manual.

The cytometer settings are renamed application settings and the 
cytometer settings icon in the Browser changes.

More information • Creating application settings (page 79)

• Recording data (page 90)

Recording data
Introduction This topic provides an example of how to preview and record data 

for multiple samples.

Before you begin Prepare the sample tubes.

Note:  If you need to run samples at an event rate greater than 
10,000 events/second, consider changing your Window extension. 
See the BD FACSDiva™ Software Reference Manual for more 
information.

Recording data To record data:

1. Press RUN and HIGH on the cytometer fluid control panel.

2. Install the first sample tube onto the SIP.

3. Set the current tube pointer to Beads_001. 
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4. Click Acquire Data in the Acquisition Dashboard to begin 
acquisition. 

5. While data is being acquired:

a. Draw a gate around the singlets on the FSC vs SSC plot.

b. Rename the P1 gate to Singlets.

c. Use the Inspector to set the other plots to show only the 
singlet population by selecting the Singlets checkbox.

6. Click Record Data.

7. When event recording has completed, remove the first tube 
from the cytometer. 
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The MyData worksheet plots should look like the following.

8. Install the second sample tube onto the SIP.

9. Set the current tube pointer to Beads_002.

10. Click Acquire Data to begin acquisition.

11. Before recording, preview the data on the MyData worksheet 
to verify that all expected populations are visible and the data 
is similar to the previous sample.

12. Click Record Data.

13. When event recording has completed, remove the second tube 
from the cytometer.

14. If you are recording more than two tubes, repeat steps 8 
through 13 for the remaining tubes.

15. Print the experiment-level cytometer settings by right-clicking 
the Cytometer Settings icon in the Browser and selecting Print.
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16. Install a tube with less than 1 mL of DI water onto the SIP. 

17. Place the cytometer in standby mode.

More information • Analyzing data (page 93)

Analyzing data
Introduction This topic describes how to analyze recorded tubes by creating 

plots, gates, a population hierarchy, and statistics views on a new 
global worksheet. 

Analyzing data To analyze data:

1. Use the Browser toolbar to create a new global worksheet. 
Rename it MyDataAnalysis.

2. Create the following plots on the MyDataAnalysis worksheet:

• FSC vs SSC

• FITC vs PE

• FITC vs PerCP-Cy5.5

• FITC vs APC

3. Create a population hierarchy and a statistics view, and set 
them below the plots on the worksheet.

• Right-click any plot and select Show Population Hierarchy. 

• Right-click any plot and select Create Statistics View. 

4. Set the current tube pointer to Beads_001.

5. Draw a gate around the singlets on the FSC vs SSC plot. 

6. Use the population hierarchy to rename the population 
Singlets.
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7. Select all plots except the FSC vs SSC plot, and use the Plot tab 
in the Inspector to specify to show only the singlet population.

8. Select all plots, and click the Title tab in the Inspector. 
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9. Select the Tube and Populations checkboxes to display their 
names in plot titles.

10. On all fluorescence plots:

• Make all plots biexponential. Select all fluorescence plots 
and select the X Axis and Y Axis checkboxes in the Plot tab 
of the Inspector.
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• In the FITC vs PE plot, draw a gate around the 
FITC-positive population. Name the population FITC 
positive in the population hierarchy.

• In the FITC vs PE plot, draw a gate around the PE-positive 
population. Name the population PE positive in the 
population hierarchy.

• In the FITC vs PerCP-Cy5.5 plot, draw a gate around the 
PerCP-Cy5.5-positive population. Name the population 
PerCP-Cy5.5 positive in the population hierarchy.

• In the FITC vs APC plot, draw a gate around the APC-
positive population. Name the population APC positive in 
the population hierarchy.

11. Format the statistics view.

a. Right-click the statistics view and select Edit Statistics 
View.

b. Click the Header tab and select the Specimen Name and 
Tube Name checkboxes.

c. Click the Populations tab and select all populations except 
All Events. Clear the %Parent, %Total, and #Events 
checkboxes.

d. Click the Statistics tab and select the mean for each of the 
fluorescence parameters.
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e. Click OK.

12. Print the analysis.
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Your global worksheet analysis objects should look like the 
following.
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More information • Reusing an analysis (page 99)

Reusing an analysis
Introduction This topic describes how to use a global worksheets to apply the 

same analysis to a series of recorded tubes. Once you define an 
analysis for a tube, you can use it to analyze the remaining tubes in 
the experiment. After viewing the data, print the analysis or save it 
to a normal worksheet.

Reusing an analysis To reuse the analysis:

1. Set the current tube pointer to the Beads_002 tube.

2. View the Beads_002 data on your analysis worksheet. Adjust 
the gates as needed.

Adjustments apply to subsequent tubes viewed on the 
worksheet. To avoid altering a global worksheet, save an 
analysis to a normal worksheet, then make adjustments on the 
normal worksheet.

3. Print the analysis.

Saving the analysis When you perform analysis with a global worksheet, the analysis 
does not save with the tube.

If you define your analysis on a global worksheet before recording 
data, you can specify to automatically save the analysis after 
recording data. You set this option in User Preferences.

To save a copy of the analysis with a tube:

1. Expand the MyDataAnalysis global worksheet icon in the 
Browser.
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2. Right-click its analysis and select Copy.

3. Click the Worksheets View button on the Worksheet toolbar to 
switch to the normal worksheet view.

4. Select Worksheet > New Worksheet to create a new normal 
worksheet.

5. Right-click the Beads_001 tube icon in the Browser, and select 
Paste.

The analysis objects from the MyDataAnalysis global 
worksheet are copied to the Beads_001_Analysis normal 
worksheet. Double-click the Beads_001 tube in the Browser to 
view the analysis.

Applying an 
analysis to normal 
worksheets

You can apply the global worksheet analysis to multiple tubes (on 
a single normal worksheet) by selecting multiple tubes before 
pasting the analysis. Ensure that you collapse all tube elements in 
the Browser before you paste them to multiple tubes.

More information • Analyzing data (page 93)



7
Technical overview

This chapter provides a technical overview of the following topics:

• About fluidics (page 102)

• About optics (page 103)

• About electronics (page 114)
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About fluidics
Introduction This topic describes the BD FACSCelesta™ flow cytometer fluidics 

system.

Pressure-driven 
fluidics system

The fluidics system in the BD FACSCelesta™ flow cytometer 
operates at a pressure of 5.5 psi. After passing through the sheath 
filter, sheath fluid is introduced into the lower chamber of the 
quartz flow cell.

Hydrodynamic 
focusing

The sample to be analyzed arrives in a separate pressurized stream. 
When a sample tube is placed on the SIP, the sample is forced up 
and injected into the lower chamber of the flow cell by a slight 
overpressure relative to the sheath fluid. The conical shape of the 
lower chamber creates a laminar sheath flow that carries the 
sample core upward through the center of the flow cell, where the 
particles to be measured are intercepted by the laser beam. This 
process is known as hydrodynamic focusing.

The objective in flow cytometric analysis is to have at most one cell 
or particle moving through a laser beam at a given time. The 
difference in pressure between the sample stream and sheath fluid 
stream can be used to vary the diameter of the sample core. 

Low sample 
pressure 
(12 µL/min)

High sample 
pressure 
(60 µL/min)

Laser beam Laser beam

Sheath 
fluid

Sheath 
fluid

Sheath 
fluid

Sheath 
fluidSample Sample
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Changing the sample flow rate changes the sample pressure 
thereby changing the core diameter. The flow rate should be set 
according to the type of application you are running.

• A higher flow rate is generally used for qualitative 
measurements such as immunophenotyping. The data is less 
resolved, but is acquired more quickly.

• A lower flow rate is generally used in applications where 
greater resolution and quantitative measurements are critical, 
such as DNA analysis.

Proper operation of fluidic components is critical for particles to 
intercept the laser beam properly. Always ensure that the fluidics 
system is free of air bubbles and debris, and is properly 
pressurized.

About optics
Introduction This topic describes the optics system and provides information 

about: 

• Light scatter (page 104)

• Fluorescence (page 104)

• Optical filter theory (page 106)

• Compensation theory (page 111)

Optics system The optics system consists of lasers, optical filters, and detectors. 
Lasers illuminate the cells or particles in the sample and optical 
filters direct the resulting light scatter and fluorescence signals to 
the appropriate detectors.
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Light scatter When a cell or particle passes through a focused laser beam, laser 
light is scattered in all directions. Light that scatters axial to the 
laser beam is called forward scatter (FSC) and light that scatters 
perpendicular to the laser beam is called side scatter (SSC). 

FSC and SSC are related to certain physical properties of cells.

• FSC. Indicates relative differences in the size of the cells or 
particles. Larger cells scatter more light and therefore they are 
higher in FSC.

• SSC. Indicates relative differences in the internal complexity or 
granularity of the cells or particles. More granular cells deflect 
more light than less granular cells, and therefore are higher in 
SSC.

Fluorescence When cells or particles stained with fluorochrome-conjugated 
antibodies or other dyes pass through a laser beam, the dyes can 
absorb photons (energy) and be promoted to an excited electronic 
state. In returning to their ground state, the dyes release energy, 
most of which is emitted as light. This light emission is known as 
fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) 
than the excitation wavelength. The difference between the 
excitation wavelength and the emission wavelength is known as 
the Stokes shift. Some fluorescent compounds such as PerCP 
exhibit a large Stokes shift, absorbing blue light (488 nm) and 
emitting red light (675 nm), while other fluorochromes such as 

Light source

Side scatter (SSC)

Forward scatter (FSC)
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FITC have a smaller Stokes shift, absorbing blue light (488 nm) 
and emitting green light (530 nm).

The following figure shows the emission spectra of some 
commonly used fluorochromes. 

Actual emission intensity will depend on excitation wavelength. 
See Fluorescence spectra (page 130) for more information on 
excitation and emission of fluorochromes. An interactive spectral 
viewer is also available at bdbiosciences.com.

http://www.bdbiosciences.com
http://www.bdbiosciences.com 
http:www/bdbiosciences.com 
http://www.bdbiosciences.com
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Optical filter theory Optical filters modify the spectral distribution of light scatter and 
fluorescence directed to the detectors. When photons encounter an 
optical filter, they are either transmitted, absorbed, or reflected.

Even though an optical filter is rated at its 50% transmission point, 
the filter passes (lets through) a minimal amount of light outside of 
this indicated rating.

The slope of an optical filter transmission curve indicates filter 
performance. A relatively steep slope indicates a high-performance, 
high-quality optical filter that provides deep attenuation of out-of-
band wavelengths. A less steep slope indicates that more light 
outside the rated bandwidth is being transmitted.

Types of optical 
filters

There are four types of filters.

• Longpass (LP) filters. Transmit wavelengths at or longer than 
the specified value.

• Shortpass (SP) filters. Transmit wavelengths at or shorter than 
the specified value. This type of filter is not recommended.

• Bandpass (BP) filters. Pass a narrow spectral band of light by 
combining the characteristics of shortpass filters, longpass 
filters, and absorbing layers. 

• Notch filters. Pass all frequencies except those in a stop band 
centered on a center frequency. They are the opposite of 
bandpass filters. 

Photons 
absorbed

Photons 
reflected

Photons 
transmitted
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The BD FACSCelesta™ uses LP filters and BP filters.

Longpass (LP) 
filters 

LP filters pass wavelengths longer than the filter rating. For 
example, a 500-LP filter permits wavelengths 500 nm or longer to 
pass through it and either absorbs or reflects wavelengths shorter 
than 500 nm.

Longpass

Wavelength (nm)
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Shortpass (SP) 
filters

An SP filter has the opposite properties of an LP filter. An SP filter 
passes light with a shorter wavelength than the filter rating. For 
example, a 500-SP filter passes wavelengths of 500 nm or shorter, 
and reflects or absorbs wavelengths longer than 500 nm.
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Bandpass (BP) 
filters 

A BP filter transmits a relatively narrow range or band of light. BP 
filters are typically designated by two numbers. The first number 
indicates the center wavelength and the second refers to the width 
of the band of light that is passed. For example, a 500/50-BP filter 
transmits light that is centered at 500 nm and has a total 
bandwidth of 50 nm. Therefore, this filter transmits light between 
475 and 525 nm.

The performance of an optical BP filter depends on the optical 
transmission. Sample transmission curves are shown in the 
following figure. A filter with a narrower (steeper) transmission 
curve generally yields higher performance. The transmission 
specifications depend on the construction of the filter.
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Dichroic mirrors Dichroic filters that are used to direct different color light signals 
to different detectors are called dichroic mirrors.

Although some of the properties of LP and SP filters are similar to 
dichroic mirrors (for example, allowing a specific wavelength 
range to pass), filters and mirrors cannot be used interchangeably, 
especially if used as dichroic mirrors. A dichroic mirror must have 
a surface coating that reflects certain wavelengths, but many LP or 
SP filters are absorbance filters that do not have any specific 
reflective characteristics. Also, optical filters and dichroic mirrors 
are rated at a specific angle of incidence. When used in front of the 
fluorescence detectors, they are perpendicular to the incident light, 
and when used as a dichroic mirror, they are placed at an angle 
relative to the light source. Their optical properties are therefore 
designed for that angle of incidence.
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Compensation 
theory

Fluorochromes emit light over a range of wavelengths. Optical 
filters are used to limit the range of frequencies measured by a 
given detector. However, when two or more fluorochromes are 
used, the overlap in wavelength ranges often makes it impossible 
for optical filters to isolate light from a given fluorochrome. As a 
result, light emitted from one fluorochrome appears in a detector 
intended for another. This is referred to as spillover. Spillover can 
be corrected mathematically by using a method called 
compensation.

In the following example, FITC emission appears primarily in the 
FITC detector, but some of its fluorescence spills over into the PE 
detector. The spillover must be corrected or compensated for. 
Alternatively, the spillover can be minimized by discrete excitation 
of fluorochromes. In the following example, excitation with a 
yellow-green configuration will help minimize spillover.

This spillover can be seen in a dot plot of FITC vs PE. The FITC 
spillover in the PE detector must be corrected as demonstrated in 
the two figures that follow.

Wavelength (nm)

N
or

m
al

iz
ed

 in
te

ns
ity



BD FACSCelesta™ Flow Cytometer User’s Guide112

Using the Compensation tab of the Cytometer window in 
BD FACSDiva™ software, you can adjust the PE-%FITC spectral 
overlap value. Compensation is optimal when the positive and 
negative FITC populations have the same medians in the PE 
parameter statistics.

The following image shows the FITC spillover optimally 
compensated out of the PE parameter.

Once fluorescence compensation has been set for any sample, the 
compensation setting remains valid for a subsequent dim or bright 
sample (provided the signal is not saturated), because 
compensation subtracts a percentage of the fluorescence intensity. 
The following figure illustrates this principle. Although the signals 
differ in intensity, the percentage of the FITC spillover into the PE 
detector remains constant.

PE
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FITC-positive 
population

Unstained 
particles

PE
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Unstained 
particles

FITC-positive 
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Matching medians
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FITC PE

Different intensity FITC signals

Same proportion or percentage of 
spectral overlap in PE channel

Wavelength (nm)

N
or

m
al

iz
ed

 in
te

ns
ity



BD FACSCelesta™ Flow Cytometer User’s Guide114

About electronics
Introduction This topic describes the electronics in the BD FACSCelesta™ flow 

cytometer

Pulse As cells or other particles pass through a focused laser beam, they 
scatter the laser light and can emit fluorescence. Because the laser 
beam is focused on a small spot and particles move rapidly through 
the flow cell, the scatter or fluorescence emission signal has a very 
brief duration—only a few microseconds. This brief flash of light is 
converted into an electrical signal by the detectors. The electrical 
signal is called a pulse. The following figures illustrate the anatomy 
of a pulse.

1. A pulse begins when a particle enters the laser beam. At this 
point, both the beam intensity and signal intensity are low.

2. The pulse reaches a maximum intensity or height when the 
particle reaches the middle of the beam, where the beam and 
signal intensity are the brightest. The peak intensity, or height 
of the pulse, is measured at this point.
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3. As the particle leaves the beam, the pulse trails off below the 
threshold.

Pulse 
measurements

The pulse processors measure pulses by three characteristics: 
height, area, and width.

• Height. The maximum digitized intensity measured for the 
pulse.

• Area. The integration of all the digitized samples over time, 
where time is the window gate plus 1/2 the window extension 
added before the initial threshold, plus the other half of the 
window extension value added after the pulse drops below the 
threshold. The window gate extends until the pulse is 75% of 
the initial threshold.

• Width. The current width is measured by the electronics. 
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Digital electronics BD FACSCelesta™ electronics digitize the signal intensity 
produced by a detector. The digitized data is stored in memory and 
further processed by the electronics to calculate:

• Pulse height and area

• Compensation

• Parameter ratios

These results are transferred to your workstation computer for 
further processing by BD FACSDiva™ software. For more 
information about digital theory, see Digital Theory in the 
BD FACSDiva™ Software Reference Manual. 

Threshold The threshold is the level at which the system starts to measure 
signal pulses. A threshold is defined for a specific detector signal. 
The system continuously samples the digitized signal data and 
calculates pulse area and height for all channels based on the time 
interval during which the threshold is exceeded.

Thresholds can also be set for more than one parameter, and pulse 
measures are based on either of the following:

• Intervals during which ALL signals exceed their threshold 
value (AND threshold in the software)

• Intervals during which ANY signal exceeds its threshold value 
(OR threshold in the software)
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Laser controls Controls in the Laser tab of the Cytometer window are used to 
manually set the (laser) delay, area scaling, and window extension 
values.

These parameters are set by BD Biosciences service personnel 
during instrument installation and performance check and are 
updated each time you run a performance check.

Note:  Do not otherwise change the settings in the Laser tab unless 
instructed to do so by BD Biosciences. Changing the settings affects 
your data.

More information • Running a performance check (page 69)
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8
Troubleshooting

This chapter covers the following topics:

• Cytometer troubleshooting (page 120)

• Electronics troubleshooting (page 128)
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Cytometer troubleshooting
Introduction This topic describes possible problems and recommended solutions 

for BD FACSCelesta™ flow cytometer issues.

Droplets are visible 
on the SIP Possible causes Recommended solutions

Worn O-ring in the retainer Replace the O-ring. See Changing the 
sample tube O-ring (page 59).

Outer sleeve is not seated in 
the retainer

1. Loosen the retainer.

2. Push the outer sleeve up into the 
retainer until seated.

3. Tighten the retainer.

Outer sleeve is not on the 
sample injection tube

Replace the outer sleeve.

1. Loosen the retainer.

2. Slide the outer sleeve over the 
sample injection tube until it is 
seated.

3. Tighten the retainer.

Waste line is pinched, 
preventing proper aspiration

Check the waste line.

Waste tank is full Empty the waste tank.

Droplet containment vacuum 
is not functioning

Call your BD service representative.

The mode is not set to HTS. Change the mode to HTS by pressing 
down the MODE button for more 
than 3 seconds.



Chapter 8: Troubleshooting 121

Sample tube not 
fitting on SIP

Rapid sample 
aspiration

No events in 
acquisition display 
and RUN button is 
green

Possible causes Recommended solutions

Sample tube other than 
Falcon® tubes used

Use Falcon 12 x 75-mm polystyrene 
sample tubes. See Equipment 
(page 148).

Worn Bal seal Replace the Bal seal. See Changing the 
Bal seal (page 57).

Sample tube is cracked Transfer contents to a new tube.

Possible causes Recommended solutions

Support arm is to the side Place the support arm under the 
sample tube.

Droplet containment module 
is failing

Try the solutions in Droplets are 
visible on the SIP (page 120). If the 
issue is not resolved, call your BD 
service representative.

Possible causes Recommended solutions

Threshold is not set to the 
correct parameter (usually 
FSC)

Set the threshold to the correct 
parameter for your application.

Threshold level is too high Lower the threshold level. 

PMT voltage for threshold 
parameter is set too low

Set the PMT voltage higher for the 
threshold parameter. 

Gating issue See the BD FACSDiva™ Software 
Reference Manual for information on 
setting gates.

Air in the sheath filter Purge the filter. See Removing air 
bubbles (page 35).
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Air bubble or debris in the 
flow cell

Prime the fluidics system. See Priming 
the fluidics (page 40).

No sample in the tube Verify that sample remains in the tube 
and if necessary, add sample to the 
tube or install a new sample tube.

Sample is not mixed properly Mix the sample to suspend the cells.

Waste tank is full Empty the waste tank.

PMT voltages set too low or 
too high for display 
parameter

Adjust the PMT voltages.

Too few events are displayed Increase the number of events to 
display.

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, clean 
the sample injection tube. See Cleaning 
the fluidics (page 47).

Bal seal is worn Replace the Bal seal. See Changing the 
Bal seal (page 57).

Instrument is not warmed up Wait 30 minutes for the instrument to 
warm up.

Laser is not functioning Verify the malfunction by changing the 
threshold to an alternative laser while 
running the appropriate sample. If 
unsuccessful, contact BD Biosciences.

Tube is cracked or misshapen Replace the sample tube.

Waste tank is pressurized. Disconnect 
the waste container for at least 
30 seconds to allow the pressure to 
dissipate.

Possible causes Recommended solutions
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No events in 
acquisition display 
and RUN button is 
orange

No fluorescence 
signal

Possible causes Recommended solutions

RUN is not activated Press the RUN button.

Sample tube is not installed 
or is not properly seated

Install the sample tube correctly on the 
SIP.

Sample tube is cracked Replace the sample tube.

Waste tubing line is 
disconnected from the waste 
container tank 

Connect the waste tubing line to the 
waste container tank.

Sheath container is not 
pressurized

 Ensure that the sheath container lid 
and all connectors are securely 
seated.

 Inspect the sheath container O-ring 
inside the lid and replace it if 
necessary. See Cleaning or 
replacing the sheath gasket 
(page 61)

Bal seal is worn Replace the Bal seal. See Changing the 
Bal seal (page 57).

Air leak at sheath container Ensure that the sheath container lid 
and all connectors are securely seated.

Sheath container is empty Fill the sheath container.

Air in sheath filter Purge the filter. See Removing air 
bubbles (page 35).

Possible causes Recommended solutions

Incorrect fluorochrome 
assignment

Make sure that the cytometer 
configuration in the software matches 
the optical filters in the cytometer and 
the configuration is as expected.

Laser is not functioning Call your BD service representative.
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No signal in red 
laser channels 
(when red laser is 
installed)

High event rate

Low event rate

Possible causes Recommended solutions

Incorrect laser delays due to 
a change in the sheath tank 
fluid level

 Check the fluid level in the sheath 
tank and refill if necessary.

Possible causes Recommended solutions

Air bubbles in the sheath 
filter or flow cell

Remove the air bubbles. See Removing 
air bubbles (page 35).

Threshold level is too low Increase the threshold level. See the 
BD FACSDiva™ Software Reference 
Manual for instructions.

PMT voltage for the 
threshold parameter is set 
too high

Set the PMT voltage lower for the 
threshold parameter. See the 
BD FACSDiva™ Software Reference 
Manual for instructions.

Sample is too concentrated Dilute the sample.

Sample flow rate is set to 
HIGH

Set the sample flow rate to MED or 
LOW.

Possible causes Recommended solutions

Threshold level is too high Lower the threshold level. See the 
BD FACSDiva™ Software Reference 
Manual for instructions.

Air bubble or debris in the 
flow cell

Prime the fluidics system. See Priming 
the fluidics (page 40).

PMT voltage for the 
threshold parameter is set 
too low

Set the PMT voltage higher for the 
threshold parameter. See the 
BD FACSDiva™ Software Reference 
Manual for instructions.
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Erratic event rate

Sample is not adequately 
mixed

Mix the sample to suspend the cells.

Sample is too diluted Concentrate the sample. If the flow 
rate setting is not critical to the 
application, set the flow rate switch to 
MED or HIGH.

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, clean 
the sample injection tube. See Cleaning 
the fluidics (page 47).

Possible causes Recommended solutions

Possible causes Recommended solutions

Sample tube is cracked Replace the sample tube.

Air bubble or debris in the 
flow cell

Prime the fluidics system. See Priming 
the fluidics (page 40).

Bal seal is worn Replace the Bal seal. See Changing the 
Bal seal (page 57).

Sample injection tube is 
clogged

Remove the sample tube to allow 
backflushing.

If the event rate is still erratic, clean 
the sample injection tube. See Cleaning 
the fluidics (page 47).

Contaminated sample Prepare the specimen again. Ensure 
that the tube is clean.

Sheath filter is dirty Replace the filter. See Changing the 
sheath filter (page 55).
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Distorted scatter 
parameters

Excessive amount 
of debris in display

Possible causes Recommended solutions

Cytometer settings are 
improperly adjusted

Optimize the scatter parameters. See 
the BD FACSDiva™ Software 
Reference Manual for instructions.

Air bubble in the sheath filter 
or flow cell

Purge the air from the filter. See 
Removing air bubbles (page 35).

Flow cell is dirty Flush the system. See Flushing the 
system (page 50).

Air leak at sheath container Ensure that the sheath container lid is 
tight and all connectors are secure.

Hypertonic buffers or 
fixative

Replace the buffers or fixative.

Possible causes Recommended solutions

Threshold level is too low Increase the threshold level.

Sheath filter is dirty Replace the filter. See Changing the 
sheath filter (page 55).

Flow cell is dirty Flush the system. See Flushing the 
system (page 50).

Dead cells or debris in the 
sample

Examine the sample under a 
microscope.

Sample is contaminated Re-stain the sample. Ensure that the 
tube is clean.

Stock sheath fluid is 
contaminated

Rinse the sheath container with DI 
water, then fill the container with 
sheath fluid from another (or new lot) 
bulk container.
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High CV or poor QC 
results Possible causes Recommended solutions

Air bubble in sheath filter or 
flow cell

 Purge the filter. See Removing air 
bubbles (page 35).

 Prime the fluidics system. See 
Priming the fluidics (page 40).

Sample flow rate is set too 
high

Set the sample flow rate lower.

Air leak at sheath container Ensure that the sheath container lid is 
tight and all connectors are secure.

Flow cell is dirty Flush the system. See Flushing the 
system (page 50).

Waste tank is pressurized Replace the waste container cap. See 
Replacing the waste container cap 
(page 53).

Poor sample preparation Repeat sample preparation.

Sample was not diluted in the 
same fluid as the sheath fluid

Dilute the sample in the same fluid as 
you are using for sheath.

Old or contaminated QC 
particles

Make new QC samples and perform 
the quality control procedure again.

Instrument is not warmed up Wait 30 minutes for the instrument to 
warm up.

Laser is not functioning Contact BD Biosciences.

Optical alignment problem Contact BD Biosciences.
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Electronics troubleshooting
Introduction This topic describes possible problems and recommended solutions 

for BD FACSCelesta™ electronics issues.

“Cytometer 
Disconnected” in 
cytometer window

Possible causes Recommended solutions

Cytometer power is off Turn on the cytometer main power.

Communication failure 
between workstation and 
cytometer

1. In BD FACSDiva™ software, select 
Cytometer > Connect.

2. If connecting does not work, 
restart the cytometer. Turn the 
cytometer off, wait 1 minute, and 
turn on the cytometer main power.

3. If connecting still does not work, 
contact BD Biosciences.
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Detector array configurations

This chapter covers the following topics:

• Fluorescence spectra (page 130)

• About configuration maps (page 133)

• About the configuration (page 134)

• Base configuration polygon maps (page 136)
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Fluorescence spectra
Introduction This topic shows sample emission spectra from common 

fluorochromes, as well as the more common laser excitation lines. 
This information is useful for designing multicolor panels. An 
interactive fluorescence viewer is available at bdbiosciences.com. 
You can also look for training by selecting Support > Training.

Designing 
multicolor panels

The BD FACSCelesta™ flow cytometer is designed specifically for 
multicolor research. Results depend on the excitation and emission 
spectra of the individual dye, the number of fluorescently labeled 
binding sites on the cell, as well as spectral overlap and spillover to 
other detectors. For more information about designing multicolor 
panels, see Selecting Reagents for Multicolor Flow Cytometry 
(Part No. 23-9538-02).

http://www.bdbiosciences.com
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Example laser and 
dye interactions

The following figure shows the emission spectra of some common 
dyes, based on laser excitation. In many cases, a given dye can be 
excited by multiple laser wavelengths, yielding different emission 
intensities.
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No Definition 

1 UV (355 nm)

2 Violet (405 nm)

3 Blue (488 nm)

4 Yellow-Green (561 nm) 

5 Red (640 nm)
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About configuration maps
Introduction This topic describes the filter and mirror arrangements in the 

detector arrays.

Filter and mirror 
arrangement

The filters are arranged in the detector array to steer progressively 
shorter wavelengths of light to the next detector in the array. The 
longest wavelength should be in the A position and the shortest 
wavelength should be in the last position used. 

There should not be any empty slots for any laser being used. 
Always use a blank optic holder. 

If a slot is filled with a filter or mirror, an identifying number 
appears in that position on the configuration map. If a slot is filled 
with a blank optic holder, that position on the configuration map is 
unlabeled.
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About the configuration
Introduction This section describes the configuration options available with the 

BD FACSCelesta™ flow cytometer.

Four available 
configurations

The configuration for a BD FACSCelesta™ flow cytometer 
supports detectors, filters, and mirrors for up to three lasers to 
provide up to 12-color detection.

The following table explains the laser configuration set up in the 
BD FACSCelesta™ flow cytometer. 

Configuration

Violet 
laser 
emission

Violet 
fluorescent 
detectors

Blue 
laser 
emission

Blue 
fluorescent 
detectors

Optional 
third 
laser 
emission

Optional 
third 
laser 
detectors

2 laser BV 405 6 488 4 - -

3 laser BVUV 405 6 488 4 355 2

3 laser BVYG 405 6 488 2 571 4

3 laser BVR 405 5 488 4 640 3
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Base configuration The BD FACSCelesta™ flow cytometer has one base configuration 
at installation. The following image shows a default base 
cytometer configuration.

More information • Verifying the configuration and user preferences (page 66)

• Base configuration polygon maps (page 136)
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Base configuration polygon maps
Introduction This section describes how filters and mirrors are arranged for 

standard polygon configurations. 

About the maps The tables in this section show the detectors, filters, and mirrors 
used in each configuration, and recommended fluorochromes for 
each detector. The word “blank” indicates that a blank optical 
holder should be used instead of an optic holder containing a 
mirror or filter. A dash (—) indicates that no slot exists for a mirror 
in that detector position.
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Four-color blue 
laser configuration

The following map shows the four-color configuration for the 
488-nm blue laser. This laser configuration is found in the BVR, 
BVUV, and BV BD FACSCelesta™ flow cytometers.

Detector LP mirror BP filter Fluorochromes

A 670 695/40 PerCP-Cy5.5

B 600 610/20 PE-Texas Red®, PE-CF594

C 550 575/25 PE

D 505 530/30 FITC, BB515

E Blank 488/10 SSC

610/20
600LP

530/30

695/40575/2
5

48
8/
10

505LP

670LP550
LP



BD FACSCelesta™ Flow Cytometer User’s Guide138

Six-color violet 
laser configuration

The following map shows the six-color configuration for the 
405-nm violet laser. This laser configuration is found in the BVYG, 
BVUV, and BV BD FACSCelesta™ flow cytometers.

PMT LP mirror BP filter Fluorochromes

A 750 780/60 BV786

B 690 710/50 BV711

C 655 670/30 BV650

D 595 610/20 BV605

E 505 525/50 BV510

F Blank 450/40 BV421

710/50
690LP

610/20

450/40

780/60670/3
0

52
5/
50

595LP

750LP655
LP

50
5L
P
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Two-color ultra 
violet laser 
configuration

The following map shows the two-color configuration for the 
355-nm ultra violet laser. This laser configuration is found in the 
BVUV BD FACSCelesta™ flow cytometer.

Five-color blue laser configuration

PMT LP mirror BP filter Fluorochromes

A 690 740/35 BUV737

B Blank 379/28 BUV395

379/28

740/35

690LP



BD FACSCelesta™ Flow Cytometer User’s Guide140

Two-color blue 
laser configuration

The following map shows the two-color configuration for the 
488-nm blue laser. This laser configuration is found in the BVYG 
BD FACSCelesta™ flow cytometer.

.

PMT LP mirror BP filter Fluorochromes

A 670 695/40 PerCP-Cy5.5

B 505 530/30 FITC, BB515

C Blank 488/10 SSC

530/30
505LP

695/40488/1
0

670LP
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Three-color red 
laser configuration

The following map shows the three-color configuration for the 
640-nm red laser. This laser configuration is found in the BVR 
BD FACSCelesta™ flow cytometer.

PMT LP mirror BP filter Fluorochromes

A 750 780/60 APC-Cy7

B 690 730/45 APC-R700

C Blank 670/30 APC

730/45
690LP

780/60670/3
0

750LP
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Four-color yellow-
green laser 
configuration

The following map shows the four-color configuration for the 
571-nm yellow-green laser. This laser configuration is found in the 
BVYG BD FACSCelesta™ flow cytometer.

PMT LP mirror BP filter Fluorochromes

A 750 780/60 PE-Cy7

B 635 670/30 PE-Cy5

C 600 610/20 PE-Texas Red, PE-CF594

D Blank 586/15 PE

670/30
635LP

586/15

780/60610/2
0

750LP600
LP
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Five-color violet 
laser configuration

The following map shows the five-color configuration for the 
405-nm violet laser. This laser configuration is found in the BVR 
BD FACSCelesta™ flow cytometer.

More information • About the configuration (page 134)

PMT LP mirror BP filter Fluorochromes

A 750 780/60 BV786

B 655 670/30 BV650

C 595 610/20 BV605

D 505 525/50 BV510

E Blank 450/40 BV421

670/30
655LP

525/50

780/60610/2
0

45
0/
40

505LP
750LP595

LP
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10
Supplies and consumables

This chapter covers the following topics:

• Ordering information (page 146)

• Beads (page 146)

• Reagents (page 147)

• Equipment (page 148)
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Ordering information
To order spare parts and consumables from BD Biosciences:

• Within the US, call (877) 232-8995.

• Outside the US, contact your local BD Biosciences customer 
support representative.

Worldwide contact information can be found at 
bdbiosciences.com.

Beads
Introduction This topic lists the QC and CS&T beads available.

QC particles

Particle Laser Supplier Catalog No.

SPHERO™ Rainbow Calibration 
Particles (8 peaks)

Blue, Violet, 
Yellow-Green 
and Red

BD Biosciences 559123

SPHERO Ultra Rainbow 
Fluorescent Particles (single peak)

Blue, Violet, 
Yellow-Green 
and Red

Spherotech, Inc. URFP-30-2

BD DNA QC Particles Blue (488 nm) BD Biosciences 349523

http://www.bdbiosciences.com
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CS&T beads

Reagents

Bead Laser Supplier Catalog No.

BD FACSDiva™ 2.0 
CS&T research 
beads

 UV (355 nm)

 Violet (405 nm)

 Blue (488 nm)

 Red (640 nm)

 Yellow-green (561 nm)

BD Biosciences  655050 
(50 tests)

 655051 
(150 tests)

Reagent Supplier Catalog No.

BD FACSFlow™ sheath fluid BD Biosciences 342003 

BD FACS™ Sheath Solution 
with surfactant (recommended 
for use with the HTS option)

BD Biosciences 336524 (USA)

336911 (Europe)

Monoclonal antibodies BD Biosciences See the BD Biosciences 
Product Catalog or the 
BD Biosciences website 

(bdbiosciences.com)

BD FACS™ Lysing Solution BD Biosciences 349202

BD Detergent Solution 
Concentrate

BD Biosciences 660585

http://www.bdbiosciences.com
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Equipment

BD FACSClean™ solution BD Biosciences 340345

Dyes and fluorochromes BD Biosciences, Life 
Technologies, or Sigma

–

Chlorine bleach 
(5% sodium hypochlorite)

Clorox® or other major 
supplier (to ensure that the 
bleach is at the correct 
concentration and free of 
particulate matter)

–

Reagent Supplier Catalog No.

Equipment item Supplier Catalog No.

Bal seal BD Biosciences 343509

O-ring, sample tube 343615

Sheath filter assembly 345734

Falcon polystyrene test tubes, 12 x 75-mm Corning  352008
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application settings

applying 89
creating 79

arm, tube support 25
aspiration (sample), rapid 121
assistance, technical 13

B
Bal seal

ordering 148
replacing 57

bandpass (BP) filters
detector array placement 29
theory 109

base configurations 136
BD Detergent Solution Concentrate 48
BD FACSClean solution 148
BD FACSDiva software See software
BD FACSFlow sheath fluid 147
BD FACSFlow solution 35
BD FACSFlow supply system 32, 49
BD High Throughput Sampler (HTS) 26
blank optical holders 41
bleach 46, 148
BP See bandpass filters
bubbles, removing air 36
buttons

fluid control 21
sample flow rate control 22

C
calculating compensation 85
capacity, waste container 27
cleaning solutions 46
compensation

calculating 85
control tubes 82
recording settings 83
theory 111

components
sheath container shown 34
sheath filter shown 55
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waste container shown 38
computer system, about 30
configuration

BD FACSDiva 66
containers

sheath 27, 33
waste 27, 38, 40

control panel, cytometer 19
controls

fluidics 19
single-stained 65, 88

conventions
safety symbols 11

creating
analysis objects 93
global worksheets 89
statistics view 93

CS&T particles 147
CV, troubleshooting 127
cytometer 17

configuration 42, 66
disconnect error 128
setup 64
starting 32
troubleshooting 120

D
Daily cleaning 47
DAPI, cleaning after using 47
data

analyzing 88, 93
gating 93
recording 88, 90

debris, excessive 126
detector arrays 28
detectors 30
dichroic mirrors

theory 110
digital data 17
digital electronics 116

Diva software See software
DNA, flow rate for analysis 103
droplet containment system 26

E
electronics

digital 116
laser controls 117
pulse 114
pulse measurements 115
threshold 116
troubleshooting 128

emission duration 114
event rate

erratic 125
high 124
low 124
zero 121, 123

excessive debris 126
excitation wavelength 104
experiments

creating 74
immunophenotyping 89
sample optimization 74
specifying parameters 75

F
FACSFlow sheath fluid 147
FACSFlow solution 35
Falcon tubes 121
filters, optical

bandpass (BP) 29, 109
dichroic See dichroic mirrors
longpass (LP) 106, 107
notch 106
shortpass (SP) 106, 108
theory 106

filters, sheath
attaching new 56



Index 151

replacing 55
FITC and Stokes shift 105
fixed-alignment lasers 17
flow cell

draining 40
fluidics 102

flow rate control buttons 22
fluid control buttons

PRIME 21
RUN 21
STANDBY 21

fluidics
description 20, 102
flow rate control 22
flushing system 50
priming 40
removing air bubbles 36
run mode 21
sample injection port (SIP) 25

fluidics controls, cytometer 19
fluidics interconnect 37
fluorescence

defined 104
emission 114

fluorescence signal, none 123
fluorochromes

compensation theory 111
emission spectra 105
measured 42
role in light emission 104

flushing the system 50
forward scatter (FSC) 104
FSC See forward scatter

G
gating data 93
global worksheets

analyzing data 93
creating 89
previewing data 88, 99

H
hazard symbol definitions 11
Help, accessing 11
High Throughput Sampler (HTS) 26
hydrodynamic focusing 102

I
immunophenotyping

analysis 93
experiment 89
hydrodynamic focusing 103

L
lasers

options 28
performance check 69
quality control (QC) particles 146

longpass (LP) filters
defined 106
theory 107

LP See longpass filters

M
maintenance

Bal seal 57
cytometer shutdown 49
sample tube O-ring 59
schedule 47
scheduled 50
sheath filter 55
system flush 50

mirrors, dichroic longpass (LP) filter 29

N
notch filters 106
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O
online Help 11
optic holder 41
optics

components 28
configuration 66, 68
dichroic mirrors 110
filters 28, 106

optimization, sample 64
ordering spare parts 146
O-ring

ordering 148
replacing 59
worn 120

P
particles 146, 147
PerCP, Stokes shift 104
performance check 69, 70
photodiode 30
photomultiplier tubes (PMTs) 29
PMT See photomultiplier tubes
polygon

shown 29
population hierarchy 93
PRIME, fluid control button 21
priming fluidics system 40
propidium iodide (PI) 47
pulse

definition 114
measurements 115
processors 115

Q
quality control (QC)

particles 146
troubleshooting 127

R
recording

compensation settings 83
compensation tubes 82
data 88, 90

removing air bubbles, filter 36
replacing

Bal seal 57
sample tube O-ring 59
sheath filter 55
waste air filter 53, 61

reusing analyses 99
RUN

button orange 123
fluid control button 21

S
safety symbol definitions 11
safety symbols 11
sample

optimization 64
optimization experiment 74
optimization, single-stained 

controls 65, 88
sample injection port (SIP)

components 25
hydrodynamic focusing 102
replacing Bal seal 57
replacing sample tube O-ring 59

sample tube
injection 25
not fitting 121
requirements 121

samples, running 90
saving analyses 99
scatter

light 104
parameter distortion 126

setup, cytometer 64
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sheath
flow 102

sheath container
components shown 34
defined 27
depressurize 34
preparing 34

sheath filter
components shown 55
ordering 148
removing air bubbles 35
replacing 55

sheath fluid 102
BD FACSFlow sheath fluid 147

shortpass (SP) filters 106, 108
side scatter (SSC) 104
signals, amplifying 29
SIP See sample injection port
software

cytometer control 10
version 30

spare parts, ordering 146
spillover 111
SSC See side scatter
STANDBY, fluid control button 21
starting cytometer 32
statistics views 93
Stokes shift 104
support, technical 13

T
technical assistance 13
thiazole orange (TO) 47
threshold, defined 116
TO See thiazole orange
troubleshooting

cytometer 120
electronics 128

tubes
Falcon 121

requirements 121

U
user preferences 68

W
waste air filter

component shown 38
waste container 27

alarm 27
capacity 27
components shown 38
defined 27
emptying 38

workstation, about 30
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